TECO

SG2 PLR USER Manual

L N niBMIsE
L X J 200000
ﬂn..*h.."h-."h-""-v"‘-

AC 1oo~240V INPUT 6 x AC

I TECO

guTPuT @ x RELAY ! BA -

SG2 Programmable Logic Relay

Secure online ordering 24/7/365 from:

B:H electronics

MANUFACTURING COMPANY
www.bb-electronics.com



a_____ 0
Table of Contents

Chapter 1: Getting Started .. ........ . 4
Examination Before Installation . ........... .. . 5
Environmental Precautions ... ... ... 5
SG2 Model Identification .. ... ... . e 5

QUICK Start SetUP . ..o 6

Chapter 2: Installation . ........ ... 12
General SPecCIfiCatioONS . .. ... e 12
Product SpecCifiCations . . ... .. .o e 13
MOUNTING ..o 14
VNG L 16

Chapter 3: Program TOOIS . ... .. e 19
PC Programming Software “SG2 Client” . ... ... .. . . 19
Memory Cartridge .. ..o 27
LCD Display and Keypad . .. ... . 28

Chapter 4: Relay Ladder Logic Programming . ..............ou i, 29
Specialty MemoOry TYPeS . ..ot e 31
OULPUL INSTIUCTIONS . . o e e e e 32
CouNnter INSIrUCHIONS . . .. e e e 34
High Speed Counters (DC Version PLRsS Only) . ... .. e 40
TIMeEr INStTUCTIONS . . .o e e e e 42
Real Time Clock (RTC) INStrUCtIONS . ... .o e e e e 49
Comparator INStrUCTIONS . . ... e e e 51
HMI Display INStrUCtIONS . .. ... e e e e e e 53
PWM Output Instruction (DC Transistor Output Models Only) ............ ... ... . ... ..... 54
Data Link/Remote I/O Instruction (SG2-20Vxx Models Only) .......... ... ... . ... 55

3 3 International Office:  www.bb-elec.com European Office: - www.bb-europe.com
Secure online ordering 24/7/365 from 707 Dayton Road - PO, Box 1040 s Commeacial Pk

a o) , Co. Galway, Ireland
$G2 PLR User Manual ‘ BB electronics  onii oo TS 0w

MANUFACTURING COMPANY orders@bb-elec.com  support@bb-elec.com  orders@bb-europe.com  support@bb-europe.com



I EEEEEE———S .

Chapter 5: Function Block Diagram Programming .. ....................... 57
Coil BIOCK INStrUCHION . . .. e e e e e e e 57
Logic BIOCK INSTrUCHIONS . ..o e e e 57
PWM Function BIOCK . ... .. . e e 58
SHIFT Function BloCK ... ... e e 58
AND LOgiC BIOCK . ... 59
AND (Edge) Logic BIOCK ... ... 59
NAND LOgiC BIOCK . ... 59
NAND (Edge) Logic BIOCK .. ... . 59
OR LOQIC ottt 60
NOR LOGIC .ottt e e e e e e e 60
XOR LOQIC ettt it e e e e 60
SR LOGIC BIOCK ... 60
NOT LOgiC BIOCK . ... e 61
Pulse Logic BIOCK . ... . 61
Counter Function BIoCK . ... . 61
Counter MOOE 5 . .. e e 62
CouNnter MOOE B . ... e e 62
High Speed Counter Function Block . ........ .. . . e 63
Timer Function BloCK . .. ... e 63
RTC Function BIOCK .. ... e e e e e 65
Analog comparator Function BloCK . ... ... . 66

3 3 International Office:  www.bb-elec.com European Office: - www.bb-europe.com
Secure online ordering 24/7/365 from 707 Dayton Road - PO, Box 1040 s Commeacial Pk

a o) , Co. Galway, Ireland
$G2 PLR User Manual ‘ BB electronics  onii oo TS 0w

MANUFACTURING COMPANY orders@bb-elec.com  support@bb-elec.com  orders@bb-europe.com  support@bb-europe.com



n Chapter 1: Getting Started

Chapter 1: Getting Started

The SG2 PLR is an electronic device. For safety reasons, please carefully read and follow the
paragraphs with "WARNING" or "CAUTION" symbols.They are important safety precautions to be aware
of while transporting, installing, operating, or examining the SG2 Controller.

m WARNING: Personal injury may result from improper operation.

& CAUTION: The SG2 PLR may be damaged by improper operation.

Precaution for Installation

T Compliance with the installation instructions and the user manual is absolutely necessary. Failure to comply could

= | lead to improper operation, equipment damage or in extreme cases even death, serious hodily injury or considerable
damage to property.
When installing the open-hoard models, insure that no wiring or foreign materials can fall into the exposed circuits
and components. Damage to equipment, fire, or considerable damage to property could result.

Always switch off power hefore you wire, connect, install, or remove any module.

The wiring for the SG2 PLR is open and exposed. For the open-board models, all electrical components are exposed.
For this reason, it is recommended the SG2 PLR be installed in an enclosure or cabinet to prevent accidental
contact or exposure to the electrical circuits and components.

Never install the product in an environment beyond the limits specified in this user manual such as high temperature,
humidity, dust, corrosive gas, vibration, etc.

Precaution for Wiring
m Improper wiring and installation could lead to death, serious hodily injury or considerable damage to property.

& The SG2 PLR should only be installed and wired by properly experienced and certified personnel.

Make sure the wiring of the SG2 PLR meets all applicable regulations and codes including local and national standards
and codes.

& Be sure to properly size cables for the required current rating.

& Always separate AC wiring, DC wiring with high-frequency switching cycles, and low-voltage signal wiring.

Precaution for Operation

To insure safety with the application of the SG2 PLR, complete functional and safety testing must be conducted.
Only run the SG2 after all testing and confirming safe and proper operation is complete. Any potential faults in the
application should be included in the testing. Failure to do so could lead to improper operation, equipment damage
or in extreme cases even Death, serious hodily injury or considerable damage to property.

When the power is on, never contact the terminals, exposed conductors or electrical components. Failure to comply
could lead to improper operation, equipment damage or in extreme cases even death, serious hodily injury or
considerabhle damage to property.

It is strongly recommended to add safety protection such as an emergency stop and external interlock circuit in case the
SG2 PLR operation must be shut down immediately.
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Chapter 1: Getting Started E

Examination Before Installation

Every SG2 PLR has been fully tested and examined before shipment. Please carry out the following
examination procedures after unpacking your SG2 Programmable Logic Relay.
* Check to see if the model number of the SG2 matches the model number that you ordered.

* Check to see whether any damage occurred to the SG2 during shipment. Do not connect the SG2 PLR to the power
supply if there is any sign of damage.

Contact FactoryMation if you find any abnormal conditions as mentioned above.

Environmental Precautions

The installation site of the SG2 PLR is very important. It relates directly to the functionality and the life
span of your SG2 . Please carefully choose an installation site that meets the following requirements:

e Mount the unit vertically

* Environment temperature: 32°F - 131°F (0°C - 55°C)

* Avoid placing SG2 close to any heating equipment

e Avoid dripping water, condensation, or humid environment

e Avoid direct sunlight

e Avoid oil, grease, and gas

* Avoid contact with corrosive gases and liquids

e Prevent foreign dust, flecks, or metal scraps from contacting the SG2 PLR

* Avoid electric-magnetic interference (soldering or power machinery)

* Avoid excessive vibration; if vibration cannot be avoided, an anti-rattle mounting device should be installed to reduce
vibration.

SG2 Model Identification

SG2 - 20 H R [-| A

|\Input Power

D = DC Powered
A = AC Powered

Controller Type

I/0 Count
8 = 8 points (expansion modules) Output Type
10 =10 I/O points _
R = Relay

12 =12 1/O points

20 = 20 I/O points T =Transistor

Form Factor

H = Encased w/ LCD & Keypad

V = Encased w/LCD, Keypad & RS-485 Communication
C = Bareboard

E = Expansion
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n Chapter 1: Getting Started
Quick Start Setup

This section is a simple 6-step guide to connecting, programming and operating your new SG2
Programmable Logic Relay. This is not intended to be the complete instructions for programming and
installation of your system. Many steps refer to other sections in the manual for more detailed
information.

1. Install SG2 Client Software
Install the SG2 Client Software from CD or from the free internet download at www.factorymation.com

g SG2-SW
Welcome to the 5G7 Clhent Sctup
Wizawrd
Ve il il 152 et s oo e — i
,,,,,, oo i o i il bl AR b Lyl S TECO Genie Il Programming Software
e or el b e Sty z ; ) The SG2 Client PC Software provides two edit modes, LADDER and FBD. The software
& includes the following features:
B
e - e 1. Easy and convenient program creation and editing.
2. Programs can be saved on a computer and accessed at any time.Programs can also
g R be upload fram the contraller and then edited.
| 3. Enables users to print programs for reference and review.
4. The Simulation Mode allows users to virtually run and test the program before it is
b loaded to the controller.
™ ] P
: Wl 5. Realtime communication allows the user to monitor the SG2 PLR operation during

RUN made.

i Download the SG2 Programming Software for FREE:

£ 4 ol do Fcl ol ol bl e £ | AT

1. Select the Download link below.
2. Select SAVE and choose a location on your harddrive to save the software.
3. RUN the sofware from the location where you saved the file.

SG2 Programming Software (4.39 MB) DOWWHLOAD MOWY

2. Connect Power to SG2 PLR

Connect power to the PLR using the below wiring diagrams for AC or DC supply for the applicable
models. See “Chapter 2: Installation” for complete wiring and installation instructions

AC (100-240V) DC (24V)

T e
100...240V @ :
so0He - E® - B

N —

N —T N %1%

%1% DC .V
TEC®

(1) Fuse (2A)
(2) Surge absorber (36V DC)
(3 Surge absorber (400V AC)
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Chapter 1: Getting Started

3. Connect Programming Cable

Remove the plastic connector cover from the SG2 using a flathead screwdriver as shown in the figure
below. Insert the plastic connector end of the programming cable into the SG2 PLR as shown in the
figure below. Connect the opposite end of the cable to an RS232C serial port on the computer.

N

4. Establish Communication
a. Open the SG2 Client software and select “New Ladder Document” as shown below.

r =]

ki . o |

File Help

HH2 !F
@ .

Mew Ladder Docurnent

TECD

Vi s
R

ss %s o9 e

File  Edit Yiew Help

1] - M ”
b. Select “Operation/Link Com Port...” as shown
Link Com Port. ..
3 3 International Office:  www.bb-elec.com European Office: - www.bb-europe.com
SG2 PLR U M I Secure online ordering 24/7/365 from 707 Dayton Road - P.O. Box 1040 Westink Commercial Park
Ottawa, IL 61350 USA Oranmore, Co. Galway, Ireland
ser Manua B electronics i oo BT 0
MANUFACTURING COMPANY orders@bb-elec.com  support@bb-elec.com  orders@bb-europe.com  support@bb-europe.com



n Chapter 1: Getting Started

C. Select the correct Com Port number where the programming cable is connected to the computer
then press the “Link” button.

‘Link Com Port E

{¢ ©ZOMI1 POET:

[ COMS PORT

(" COMZ PORET ( COMS POET
(" COM3 PORT ( COM? POET

(" COM4 PORT ( COMS POET

Link | Unlink | Clase |

d. The SG2 Client will then begin to detect the connected PLR to complete it's connection as shown
below.

IPlease Wait a Moment!

Hooar Detect 3G2 [0 =1
l i Caneel

5. Write simple program

a. Write a simple one rung program by clicking on the leftmost cell at line 001 of the programming
grid, then click on the “M” contact icon on the ladder toolbar, as shown below. Select M1 and
press the OK button. See Chapter 4: Ladder Programming instructions for complete instruction
set definitions.

SO G ZEA eEeeeE o

" 88 T T r—
|
A T

dddo i T W bo b dai £ 8 f 21

Note: If the ladder toolbar is not visible at the bottom of the screen, select View>Ladder Toolbar from the
menu to enable.
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Chapter 1: Getting Started H

b.

circuit line from the M contact to the right most cell, as shown below.

DY e EISIA A ST o

"oiwad in Frew

ddidcidoRadaadadadd L) Hm

e

C.

@‘

B el -

Use the “A” key on your keyboard (or the “A” icon from the ladder toolbar) to draw the horizontal

Select the “Q” coil icon from the ladder toolbar and drop it on the right most cell. Select Q1 from

the dialog and press OK as shown below. See Chapter 4: Ladder Programming instructions for

complete instruction set definitions.

@l ERAs STSesN &

il s By

-

el ol gl ool ] i R BRI

[ - v o
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n Chapter 1: Getting Started

d.

e.

Test the simple program. From the Operation menu, select the Write function and write the
program to the connected PLR as shown below.

AD Version:1.4
File Edit Sefaf==lly

[ Monitor

Simulator

Coilld | |
Symbo] Fun! Chrl+R
v Stop | Chl+T
Lik Chrl+
* 1 lsed Q s
I:1234! Read
Write
XilZag.
RTC Setk...
0r1234. Passward. ..
* Language. ..
ve1734 Module System Set..

Link Com Port...

—- A m s oA

Select the RUN icon from the toolbar, and select “No” when the pop-up message asks “Do you
want to read program from module?”, as shown below.

- LAD Version:1.4

Do @ HEEE oF@wens

Coil/Contact: Capacity: 796 free apace.
Symbol:

:Used in Prog.

{%}5
=

I:123456TAOABC
X: 123456 TB0ARC
Q12345670 Fil
-
T:1Z3456TROABC o003
M: 123456 TEGARCDEF
-

T: 121456 709ABCDER Lz
C:1Z3456TEPABCDER

005
R:1X314567BOABCDEF
G: 123456TAGABCDEYF

ooe
H: 123456 TEOABCDEY

; = Message

L|123456£E ”nj
D0 ?J [0 You Wik To Read Program From Moduls 7

ooa
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Chapter 1: Getting Started n

f. From the Input Status dialog, click on M1 to activate the contact M1 which will turn ON the Output
Q1, as shown below. The highlighted circuit will show active and the first Output (Q1) on the
connected PLR will be ON. See Chapter 3: Programming Tools for more detailed software
information.

Bl HEC [ SReeeEE e

Coil/Contact: Capacity: 796 free space.
3}1|:':|._-||.:
ol
Tiotatus Cm O—
I:123456T89ABC
¥:123458 78 OARS Input Status Toal
Q: 12345678 Prl e o T
. 2lalalelalalom
Iz lzix |z i {x GILL
¥: 123456 TORABT
Ly 7 89 A #H G o3
M:12345678 GABCDER e et ] il
*
T: 12345678 9ABCDER j i “':'4
b gl gl @] &l o
= P
i |uinm {m OLE
£ 12 ' B 3
C: 123456 TEDABCDEP e | P
ol elolalelolm Qo3
R:123456 768 9ABCDEF [}'I’;‘JE':T‘?"?':"M:
< D EF
G:123456TEBARCDER &] alofm
[x[=fx ofe 0oe
H:123458TEOABCDEF ¥:1 23 458
ol ololelelolion
L: 12345678 [ [xh hfzlx ote]| gos
¥ 8% AR C
¢]alolalelaltn
= iz % Is =z |= OLf
aos
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Chapter 2: Installation

General Specifications

SG2 is a miniature smart PLR (Programmable Logic Relay) with a maximum of 44 1/O points and can
be programmed in Relay Ladder Logic or FBD (Function Block Diagram) program. The SG2 can

expand to its maximum 1/O count by adding 3 groups of 4-input X 4-output modules.

Power Supply

Discrete Inputs

Input Power Voltage Range

DC Models: 20.4-28.8V
AC Models: 85-265V

Power Consumption

24VDC: 10-point, 90mA
20-point: 150mA
100-240VAC: 90mA

Current consumption

4mA @12vDC
3.2mA @24VDC
1.3mA @100-240VAC

Input Signal "OFF” Threshold

< 5VDC; < 40VAC

Wire Size (all terminals)

26 to 14 AWG

Input Signal "ON” Threshold

> 15VDC; > 79VAC

Programming

Programming languages

Ladder/Function Block

Input On delay

DC: 5ms
240VAC: 50ms
120VAC: 90ms

Program Memory

200 Lines or 99 Function Blocks

Programming storage media

Flash

Execution Speed

10ms/cycle

Input Off Delay

DC: 3ms
240VAC: 50ms
120VAC: 90ms

LCD Display

4 lines x 12 characters

Transistor device compatibility

PNP, 3-wire device only

Timers

High Speed Input frequency

1kHz

Maximum Number

15

Standard Input frequency

<40 Hz

Timing ranges

0.01s-9999min

Required protection

Inverse voltage protection required

Counters

Analog Inputs

Maximum Number 15 Resolution 10 bit
Highest count 999999 Analog input: 0-10VDC,

: Voltage Range acceptable 24VDC when used as discrete input
Resolution 1
RTC (Real Time Clock) Input Signal "OFF” Threshold  |< 5VDC (as 24VDC discreet input)
Number available 15 Input Signal "ON” Threshold > 9.8VDC (as 24VDC discreet input)
Resolution 1min

Time span available

week, year, month, day, hour, min

Compare Instructions (Analog, Ti

mer, or Counter Values)

Number available

15

Compare versus other inputs

Timer, Counter, or Numeric values

Environmental

Enclosure Type

IP20

Isolation None
Short circuit protection Yes
Total number available A1-A8
Relay Outputs

Contact material Ag Alloy
Current rating 8A

Maximum Vibration

1G according to IEC60068-2-6

HP rating

1/3HP@120V 1/2HP@250V

Operating Temperature Range

32° to 131°F (0° to 55°C)

Storage Temperature Range

-40° to 158°F (-40° to 70°C)

Maximum Load

Resistive: 8A/point
Inductive: 4A/point

Maximum Humidity

90% (Relative, non-condensing)

Maximum operating time

15ms (normal condition)

0.075mm amplitude

Life expectancy (rated load)

100k operations

Minimum load

16.7mA

Transistor OQutputs

PWM max. output frequency

0.5kHz (1ms on,1ms off)

Vibration 1.0g acceleration
10-point: 230g

Weight 8-point:190g
20-point: 3459

Agency Approvals cUL, CE, UL

SG2 PLR User Manual
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Resistive: 0.5A/point
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Chapter 2: Installation H

Product Specifications

Part # Input Power Inputs Outputs Display RS-485 Communications Max 1/0*

S$G2-12HR-D 6 DC, 2 Analog 4 Relay v/ N/A 36

SG2-12HT-D 6 DC, 2 Analog 4 Trans. 4 N/A 36

S$G2-20HR-D 24 VDC 8 DC, 4 Analog 8 Relay v/ N/A 44

SG2-20HT-D 8 DC, 4 Analog 8 Trans. v/ N/A 44

S$G2-20VR-D 8 DC, 4 Analog 8 Relay v/ Built-in MODBUS 44

S$G2-20VT-D 8 DC, 4 Analog 8 Trans. v/ Built-in MODBUS 44

SG2-10HR-A 6 AC 4 Relay v/ N/A 34
85-240 VAC

S$G2-20HR-A 12 AC 8 Relay v/ N/A 44

Expansion Modules

SG2-8ER-D 2AVDC 4DC 4 Relay N/A N/A N/A

SG2-8ET-D 4DC 4 Trans. N/A N/A N/A

SG2-8ER-A 85-240VAC 4 AC 4 Relay N/A N/A N/A

SG2-4A1 12-24 VDC 4 Analog N/A N/A N/A N/A

S$G2-MODBUS 24 VDC Communications Module, RS-485 MODBUS-RTU

OEM “Blind” Models, No Keypad, No Display

S$G2-12KR-D 6 DC, 2 Analog 4 Relay X N/A 12
24VDC

SG2-20KR-D 8 DC, 4 Analog 8 Relay X N/A 20

SG2-10KR-A 6 AC 4 Relay X N/A 10
85-240VAC

S$G2-20KR-A 12 AC 8 Relay X N/A 20

OEM “Barehoard” Models, No Keypad, No Display, No Expansion

SG2-12CR-D 6 DC, 2 Analog 4 Relay X N/A 12
24VDC

S$G2-20CR-D 8 DC, 4 Analog 8 Relay X N/A 20

SG2-10CR-A 6 AC 4 Relay X N/A 10
85-240VAC

S$G2-20CR-A 12 AC 8 Relay X N/A 20

Accessories

SG2-PLO1 SG2 Programming Cable

S$G2-PM05 SG2 Memory cartridge

SG2-SW SG2 Programming software. Available on CD or FREE via download from Web
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Mounting

DIN-rail Mounting

The SG2 PLR should always be mounted vertically. Press the slots on the
back of the SG2 and expansion module plug CONNECTOR onto the rail
until the plastic clamps hold the rails in place. Then connect the expansion
module and CONNECTOR with the Master (press the PRESS-BUTTON
simultaneously)

CONNECTOR
w .
A + - 112 13 14 15 16 A A2 ’ 4 J:% X1 X2 X3 X4 PRESS-BUTTON
A0 00D DIVIVIS)
DC24V  Input 8 x DC(A1,A2 0~10V) ) 6 é AC 100-240V
ﬂ TECD TEC
ZON N gy —
— o Sl 1™
30 5
‘ NOZ | i“ |

o o é SG2-8ER-A s

f SG2-12HR-D | Output 4 x Relay / 8A 4‘

’ Output 4 x Relay / 8A ‘ WA l ®,Y1CD®®79 ) )
| || = Din Rail
Q0 00 00 O L_)l|[ 00000
Q1 Q2 Q3 Q4 Y3 Y4
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Chapter 2: Installation E

It is recommended to apply a DIN-rail end clamp to hold the SG2 in place.

+ - M 12 13 14 15 16 AT A2 Input X1 X2 X3 X4
00 00000000 e 0000 Mounting Clip
DC 24V Input 8 x DC(A1,A2 0~10V) L N AC100~240V

00
] f— TECD TEC®

7N I o

K
- Q: §=>@§ ®

[ ] SG28ERA
|  sG2-12HR-D

Output 4 x Relay / 8A

00000

!

Output 4 x Relay / 8A Y1 V2 Din Rail
OO 0O OO 00 OO00000O
Q1 Q2 Q4 Y3 Y4
Direct Mounting *
Use M4 screws to direct m
mount the SG2 as shown. T - 1. ?\.4 5 6 AR

For direct installation of the
expansion module, slide the

expansion module and :
connect with the Master 77 @§| M4X20(#8x32)

after the Master is fixed. @ % @@

DC24V INPUT8xDC(A1,A2 0~10V)

SG2-12HR-D
OUTPUT4xRELAY/8A
Lsd sd [ Lsd
Q1 Q2 Q4

Ld]
v
() (6]

- M 12 13 14 15 16 AT A2 ‘ Input X1 X2 ><
00 50000600 ] 0000
DC 24V Input 8 x DC(A1,A2 0~10V) L N AC100~240V M4X20(#8X32)
® o2 o
TEC® o L | TEC® 3
I‘ <>®> ‘l @ q %lr ‘ Q Run
v € =
Il
N4 _
$G2-12HR-D ooy on
CONNECTOR P
‘ Output 4 x Relay / 8A ’ M ‘ ‘ ‘ Q{QOQP /f:
‘ OO 00 OO 0O ‘ OOOO?O \
Q1 Q2 a3 Q4 Y3 Y4
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E Chapter 2: Installation

Wiring

WARNING: The 1/0 signal cables should not be routed parallel to the power cable, or in the same cable trays to avoid

the signal interference.

& To avoid a short circuit on the load side, it is recommended to connect a fuse between each output terminals and loads.

Wire size and Terminal Torque

= D= [ F—
= D ] o F—
mm2 0.14..1.5 | 0.14...0.75 | 0.14...2.5 0.14...2.5 0.14..1.5
AWG 26...16 26...18 26...14 26...14 26...16
C
@3.5 C
(0.14in) @ Tb-in 54
10/12-point Versions === 0-10V Analog
1 2
(1) Fuse (2A) [ |
(2) Surge absorber (36V DC)
(3 Surge absorber (400V AC)
@ Fuse or short circuit Protective Device (DA DA
|
Power Supply and Input Terminals @ +- AT A2
"= 24V t
—— 24 ™
100...240V % RRRRRRR % RRRRRRR
~ KR @ P
50/60 H
e s IR AARRARD =T 1NN
N 1 12 13 14 15 16 - 1 12 13 14 15 16 A1 A2
(%1%) (D011 %1%)%) DC (24V) DO QLYY
Ac (1 00'24BV) AC.V Input ...... DC .V Input ...
TECD TEC®
= =24\ | § N e =2\ | B
e T ~—— T B [ e e -
Output 4 x Relay / 8A OUTPUT 4 xTR/0.5A | I
Output Terminals %? %? @cg @f? @C“@ @02@ @m@ @m@

@ ||| @ || |
12..240V ~ L+ 1 o+
50/60 Hz m— i 24v — — 11 L

or .
or12..125V — NI- E|j E|j 12V = - E|j E|j |

12...240V 50/60 Hz
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Chapter 2: Installation H

20-point Versions

(1) Fuse (2A) === 0-10V Analog

(2) Surge absorber (36V DC) 1 3 3 4
(3 Surge absorber (400V AC) [ [ [ |
() Fuse or short circuit Protective Device

AP D2A DD

— 1| [ ————

T

Power Supply and Input Terminals ‘

L ,@‘ + ,@l+' Alpa™pg
¥a RRRERRRRERRRR oy RRA
N D ) = N\ m
AC (100-240V) | 00 Q000 0000 Q000eeee DERY) | oo  0ooo 000D 55550000
AC ..V INPUT ...... DC.V INPUT ...
ATEC® e — | TEC O Run B
Output Terminals
. X
P @R D PP PP
®
12..240V ~ 1 qy — % N
50/60 Hz L or i N
z LN
or12..125V — N/- E|j E|j T | U 12V = - E|j E|j v

Sensor Connection

Fuse 1

T—- 2LV + .' |

or ~ 3-wire, PNP only

- I YES

BL BN BL BN
BK | BK
- 1 12 13 14 15 16 A1 A2

@@ AN NN,

DC .V Input ... 2-wire

TEC® NO

- ——

3 3 International Office:  www.bb-elec.com European Office: - www.bb-europe.com
SG2 PLR U M | Secure online ordering 24/7/365 from . 707 Dayton Road- PO, Box 1040 oStk Commercial Park
Ottawa, IL 61350 USA Oranmore, Co. Galway, Ireland
ser Manua B electronics i oo BT 0
MANUFACTURING COMPANY orders@bb-elec.com  support@bb-elec.com  orders@bb-europe.com  support@bb-europe.com



E Chapter 2: Installation

DATA LINK OR REMQOTE I/0O LINK
(1) The power supply and the I/0 supply should share the same power source.
(2) Only short circuit the first and the last module.

In accordance to EIA RS-485 standard, DATA LINK can connect Max.8 Modules (ID:1-8). REMOTE 1/O
can only connect 2 modules (MASTER & SLAVE).

me/ I W mﬂ\\

A1 A2 A3 A4 S A B A1 A2 A3 A4 S A1 A2 A3 A4 S
) RS485 ) RS485 ) RS485
. . i ice: .bb-elec. E Office: .bb- .
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Chapter 3: Program Tools E

Chapter 3: Program Tools
PC Programming Software “SG2 Client”

The SG2 Client programming software provides two edit modes, Ladder Logic and Function Block
Diagram (FBD). The SG2 Client software includes the following features:
1. Easy and convenient program creation and editing.

2. Programs can be saved on a computer for archiving and reuse. Programs can also be uploaded directly from an
SG2 and saved or edited.

3. Enables users to print programs for reference and review.

4. The Simulation Mode allows users to run and test their program before it is loaded to the controller.

5. Real-time communication allows the user to monitor and force 1/0 on the SG2 PLR operation during RUN mode.
Installing the Software

Install the SG2 Client Software from CD or from the free internet download at www.factorymation.com

ST
M
Welcomie to the SG2 Chent Setup
Wizard T ,
e TECO Genle | Pragramming Saftware
eormerded fal oui Ui ol e sy shor beices ] 8 The 502 Chent PC Saftwam peowdes fan sl modes, LADDER wnd FED. The sobwarm
_ a inchifus e Flkneing b aturey
[ |
y I Emvy wsd comvanesm peogram crasbon
2. Piograms ie T
- fonrs =
[
] 5 Fesbteg communigaion alpes fhe user by mosd e the 362 PLR operatan gy
BN mod
TET | o el Sl P Diownilpad the 507 Prograenmesg Softears for FRCL

|, Sslect the Downlsad lnk below
& Setect SAVE and chonse a ncation on you harddees ts savw (he sotwae
1 TN (e ashvais kam (he ooalion wieme pay peed ihe s

SIE2 Pepgranmming 5 olwien (.39 MET) DOWHLOAD B0

Connecting the Software

Remove the plastic connector cover from SG2 using a flathead screwdriver as shown in the figure
below. Insert the plastic connector end of the programming cable into the SG2 PLR as shown in the
figure below. Connect the opposite end of the cable to an RS232C serial port on the computer.

Start Screen

Run the SG2 Client software and the following Start screen will be displayed. From this screen, you can
perform the following functions

=y
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m Chapter 3: Program Tools

New Ladder Program

Select File-->New-->New LAD to enter the
development environment for a new Ladder
program.

® SG2 Chent

New FBD Program

Select File-->New-->New FBD to enter the
development environment for a new FBD
(Function Block Diagram) program.

Open Existing File
Select File-->Open to choose the type of file

to open (Ladder or FBD), and choose the
desired program file, and then click Open.

¥® 8% w¥E 0w

Ladder Logic Programming
Environment

The Ladder Logic Programming Environment

includes all the functions for programming and

testing the SG2 PLR using the Ladder Logic programming language. To begin a new program select
File-->New--> and select the desired model of SG2, and the number of connected expansion units if
applicable, as shown below.

I Select Model Type !

Specifications

o Besaenes SGE-12HR-D:
| o v ) 11} Power : EZ4 YLC
TECD Fod (2) Imput - I1-If_ AL, AZ
- (3) Output : 4xRelay/ 54
E— L'o‘-“ (4} Analog @ YTes
{EY RBTC : Yes

(61 PUM Output: Mo
(71 lFHz Input: I1-IZ

Expansion )
18) High Speed Comm.: No
DISD0 {9) LCD/Eeypad: Yes
“ - Select Type
BGZ-1EZHE-D -
O Cancel
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Chapter 3: Program Tools E

Menus, lcons and Status Displays
The Ladder programming environment includes the following Menus, Icons and Status Displays

1. Menu bar — Five menu selections for program development and retrieval, editing, communication to connected
controllers, configuration of special functions and viewing preference selections.

2. Main Toolbar — (From Left to Right)
Icons for a New program, opening a program, and printing
Icons for Keypad, Ladder view, HMI/Text editing and Symbol (comments) editing.

Icons for Monitor, Simulator, Controller Mode changes (Run, Stop, and Quit), and Read/Write programs to/from the
PLR.

3. Usage List — List for all memory types and addresses used with the current open program. Used addresses are
designated by a “*” symbol below each address.

4. Amount of free programming memory available.

5. Current Mode — operation mode of the controller, or simulator, from the connected PC.
6. Ladder Toolbar — Icons for selecting and entering all available Ladder Logic instructions.
7. Status Bar — Status of current open project and connected PLR.
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E Chapter 3: Program Tools

Programming
The SG2 Client software can be programmed by either drag-and-drop of instructions or by using

keyboard entry commands. Below is an example of some common methods of entering programming

instructions.
]

B e brgas

Chick-
&-drag

(éﬁ#.’.eﬁﬁiﬁynm | S5 ey

The “A” and “L’ keys or icons are used to complete parallel and serial circuits. The rightmost column is

for output coils.

i @l s s e o
NI - A . B ke -
P 1k ‘
= 1 Cod eolurmn
& fior outputs
o
M |
G (|
-
11 '
b
I 4o form
ol e oo ol Fn e B Fo FE e
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Chapter 3: Program Tools E

Simulation Mode

The SG2 Client software includes a built-in simulator to test and debug programs easily without the need
for downloading to a controller. To activate simulation mode, simply press the red RUN icon. The
program below is shown in simulation mode, identifying the significant available features.

[EE - S S L [
R —— —— 2 Msle) Bassisrer |
e} I..I:n:tlhrl TD%]B : |
F——— S]mu].ath:ln K [ e
Mode ) . | == e o e
Highlight coil
torwiewr current
TurertCounter
wralues
Artmve ciromts
change color

Establish Communication

The following is the simple procedure for establishing communication between the connected PC and
the SG2 PLR.

a. Select “Operation/Link Com Port...” as shown below.

Wigw  Help

Link Com Part. ..
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ﬂ Chapter 3: Program Tools

b. Select the correct Com Port number where the programming cable is connected to the computer then
press the “Link” button.

‘Link Com Port g

[ COMS PORT

[ COM2 PORT ( COMS PORT
[ COM3 POET ( COM7 PORT

(" COM4 POET ( COMEZ PORT

|L:‘nk | Erﬂ.i.tﬂ{| glose|

c. The SG2 Client software will then begin to detect the connected PLR to complete it's connection as
shown below.

IPlease Wait a Moment'!

Menar Detect 3G2 [D =1

Writing Program to PLR

From the Operation menu, select the Write function and write the program to the connected PLR as
shown below.

Manitor

Sirmulatar |
Coil fun | Ctrlen,
Syrho . ur | Fl+
v Stop | Chrl+T
Cuit Chrl+c
*:Tzed
I:1234) Read
I'.'I'.'IritEf
:1234.
RTC Set...
Password. ..
Q1234
. Language...
Module Svwstem Set. ..
¥:1234. ¥
Link Corn Port, .,
A AT ALY L B T TP
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Chapter 3: Program Tools E

Operation menu
The Operation menu, includes several system configuration functions for both online and offline setup.

The following explains the details of each function.
Monitor — Online function for runtime monitor and editing when connected to a controller
Simulator — Offline function for testing and debugging a program.

Run-Stop-Quit — Mode change selections for both runtime editing and simulation mode.

Read-Write — Reading and writing programs to and from a connected PLR.
RTC Set — Online function for setup of the Real-time clock/calendar (see dialog below)

RTC Set

Time Set
Year /Manth /Day: | ;| / |

Hour: Minute : |

Cancel |

Password — Set a password for accessing the current program after upload to the PLR

Language — Change software language

Module System Set — Dialog for changing important system setup functions including Module 1D,
Remote I/O preferences, Expansion I/O settings, and Retentive memory preferences (Keeping) for (C)
Counters, (M) Auxiliary Coils, and the LCD Backlight.

Online Monitoring/Editing

The SG2 Client software allows for online monitoring of the currently running program during runtime.
Additional online functions include, 1/O forcing, and Mode changes (Run/Stop/Quit).

Note: The SG2 Client software does not support runtime logic editing changes. All logic edits to contacts, coils,

timers/counters, and circuit connecting lines must be written to the connected PLR while in Stop mode.
EC SR S a‘@‘n-, ©
ke T 1 TD%]B
RunfStop
Ilode i Pt
T T e e
Il =R ~y
i T
Foree 11D . /
points | :
. e | T
(1 i I L
e | |
— " |I |
revane =1 ‘ 1 | |
of 1) | |
5 ,I
"""" 1 | 1 H Highlight col
- | f { I _\ | to view current
[ | TimeriCounter
| “ralnes
|
R i SE= = i == —f )
f f
| I|
Status Bar: Filename, Firorare Ectrve civonits
wersior, lode, Online /O line, change color
552 Model, and ID#
i —
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E Chapter 3: Program Tools

Program Documentation

The SG2 Client software includes the ability to document a program using Symbols and Line
Comments. Symbols are used to label each 1/0O address up to a length of 12 characters. Line
Comments are used to document sections of a program. Each Line Comment can have up to 4 lines
with each line containing up to 50 characters in length. Below are examples of entering Symbols and
Line Comments.

Symbol

The Symbol editing environment can be access through the menu using the Edit>Symbol... selection or
using the symbol icon on the main toolbar shown below.

The Symbol editing environment allows for documenting all the contact and coil memory types, and
selecting display modes as shown below.

LE LAD Version: 1.4
Qperation  Wiew Help

Select Modsel. ., EI rr-l-ij

. keyPad I
Sy v Ladder

Clear Comments

Find. ..

", Replace...

il HMLText...

Symbal, ..
Q154060 Pl

Line Comments

Contact/Coil Symbol
Lakel Svmbol Contact fCoil
; * T (Input Contact)
T1 Btart
= ¥ (Expand Input Contact)
Iz Return Prif. .
H—— 0 (Output. Contact/Coil)
Iz End EStrok
| i EREE T (Expand Output Contackt)
o ;Hutnr BEL. M {Auxiliary Contact)
L& T (Timer Contact)
Is Maint. Deset C {(Counter Contact)
I7 B (RTC Contact)
Is G (inalog Contact)
Io ﬁane Minn Time H (HMI/Text Contact)
o i P (PWM Output Contact)
L (Data Link Contact)
IE |
I . . Display Enable
ContactCoil
Symbol + Both
OE Cancel
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Chapter 3: Program Tools H

The Line Comment editor is accessed by clicking the “N” icon on the Ladder Toolbar. After clicking on
the “N” icon, to drag the line number you want to comment and release, then type the desired comments

and press OK.

Lime 1
Lira 2: [Hmintenance & Total Time Routins Pegins Delow
—]
Line 1 .
Line 4: i
| oKX Cancel

# Click-&-
oxg I release

' |

0z9 _i l— I
o |

I
[ |
¥
el Min C ,
I

031 _i —

i e

i ) ) ) o ol LGN A1 P e

Stabus Slop OHLINE | Model SG2-2MT.D i

Maint Mc

PeckDdb- 2100 Paulled g Yer 16

Memory Cartridge (sold separately)
The optional PM0O5 memory cartridge is used to easily transfer programs from one PLR to another. The
PMO5 memory cartridge plugs into the same connector as the programming cable (see procedure below).

1. Remove the plastic connector cover from SG2 using a flathead screwdriver as shown in the figure above.
2. Insert the PM05 memory cartridge onto the connector as shown above.

3. From the display keypad on the face of the SG2 PLR, select either WRITE (to PMO05) or READ (from PMO05) to
transfer the program to or from the PLR to the PM05 memory cartridge.
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E Chapter 3: Program Tools

LCD Display and Keypad

Most SG2 CPU units include the built-in LCD Display and Keypad. The keypad and display are most
often used for changing timer/counter setpoints, controller mode changes (Run/Stop),
uploading/downloading to the PM05 memory cartridge, and updating the RTC (Real Time
Clock/Calendar). Although, logic programming can be performed from the keypad and display, it is highly
recommended to only perform logic changes using the SG2 Client software. Below is an overview of
the basic keypad and display functions.

SG2 PLR User Manual ‘

Select — Used to select the available memory and instruction types for
editing. Holding the Select button for 3 seconds (and releasing) will
display all “H” HMI/Text messages on the LCD.

OK — Used to accept the selection displayed of an instruction or
function. It is also used to select any of the Main Menu options on the
LCD.

Note: Press the “SEL” and “OK” simultaneously to insert a rung above the current
active cursor position.

Escape — Used to exit a selected display screen and go to the previous
screen. When in a ladder display screen, press the ESC to display the
main menu.

Delete — Used to delete an instruction or rung from the ladder program.

The 4 navigation buttons are used to move the cursor throughout the
functions of the SG2 display or active program.

Secure online ordering 24/7/365 from International Office: www.bb-elec.com European Office: www.bb-europe.com

707 Dayton Road - P.O. Box 1040 Westlink Commercial Park

3 o , Co. Galway, Ireland
B electronics i oo BT 0

MANUFACTURING COMPANY orders@bb-elec.com  support@bb-elec.com  orders@bb-europe.com  support@bb-europe.com



Chapter 4: RLL Programming E

Chapter 4: Relay Ladder Logic Programming

Common Memory Types

Inputs (I Memory Type)

The SG2 digital input points are designated |
memory types. The number of digital I input
points are 6, 8, or 12 depending on each

SG2 model.
Outputs (Q Memory Type) oo1 N >
The SG2 digital output points are designated !

Q memory types. The number of digital Q

output points are 4 or 8 depending on each

SG2 model. In this example, output point Q1

will be turned on when input I1 activated.
Auxiliary Relays (M Memory Type)

Auxiliary relays are digital internal memory

bits used to control a ladder logic program.

The auxiliary relays are not physical inputs or
outputs that can be wired to any external

device; switches, sensors, relays, lamps, etc. .,

M1

| )
Since auxiliary relays are internal bits within _< | O_
the CPU, they can be programmed as digital m1 Qz
inputs (contacts) or digital outputs (coils). In 902 | (O—
the first rung of this example, auxiliary relay -
M1 is being used as an output coil and will
energize when input I2 turns on. In the o C
second rung auxiliary relay M1 is being used
as an input and when energized, will turn on
outputs Q2 and Q3.

Timers and Timer Status Bits (T Memory Type)

Timer status bits provide the relationship between the current value and the preset value of a selected
timer. The timer status bit will be on when the current value is equal or greater than the preset value of a
selected timer. In this example, when input I3 turns on, timer T1 will start. When the timer reaches the
preset of 5 seconds timer status contact T1 turns on. When T1 turns on, output Q4 turns on. Turning off 13
will reset the timer.

13 1
005 _< | Y 1
| e 24 ooo.o
005.0 pri
T o4
oe (] &
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ﬂ Chapter 4: RLL Programming

Counters and Counter Status Bits (C Memory Type)

Counter status bits provide the relationship between the current value and the preset value of a selected
counter. The counter status bit will be on when the current value is equal to or greater than the preset
value of a selected counter. In this example, each time the input contact 14 transitions from off to on, the
counter (C1) increments by one. When the counter reaches the preset of 2 counts, the counter status
contact C1 turns on. When C1 turns on, output Q5 turns on. When M2 turns on counter C1 will reset. If
M9 is turned on, the counter will change from a count-up counter to a count-down counter.

14 1
oo1i _{ | P 1
| e v 0ooooo
000002 pel
o1 a5 -
0oz 4H 1
Mz
0o3 40_

Common Memory Types

General output | SET output | RESET output | PULSE output | N.0. Contact | N.C. Contact Number
Symbol 0 1) (1) P) —IF =41 (N.O./N.C.)
Input contact I i 12 (I1-IC / i1-iC)
Output coil Q Q Q Q Q q 8 (Q1-Q8/ q1-g8)
Auxiliary contact M M M M M m 15 (M1-MF / m1-mF)
Counter C C c 15 (C1-CF / c1-cF)
Timer T T T t 15 (T1-TF / t1-tF)

Specialty Memory Types

General output | SET output | RESET output | PULSE output| N.0. Contact | N.C. Contact Number
Symbol 0O ) (1) P) —IF -4/ (N.O./N.C)
Expansion input coil X X 12 (X1-XC /x1-xC)
Expansion output coil Y Y Y Y Y y 12 (Y1-YC / y1-yC)
Differential (one shot) D (Positive) | d (Negative)
RTC R R r 15 (R1-RF / r1-rF)
Analog comparator G G g 15 (G1-GF / g1-gF)
HMI H 15 (H1-HF)
PWM P 1 (P1)
DATA LINK L 8 (L1-L8)
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Chapter 4: RLL Programming E

Specialty Memory Types

Positive Input Differential Instruction (One-Shot)

An positive input differential instruction, or One-Shot, holds its status ON for one CPU scan when the
preceding series contact transitions from OFF to ON. This transition from OFF to ON is called a Positive
Input Differential.

I1 D 21
| |
] (O
2l
11 OFF ON OFF
D OFF ON OFF
1:{—:‘.;(_}1'11’.' complete scan period
) OFF ON OFF

Negative Input Differential Instruction (One-Shot)

A negative input differential instruction, or One-Shot, holds its status ON for one CPU scan when the
preceding series contact transitions from ON to OFF. This transition from ON to OFF is called a
Negative Input Differential.

Il d o
I1 OFF | oN | OFF
d OFF OM I OFF
1 One comp lete =can
Q OFF II}'.\'I OFF
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E Chapter 4: RLL Programming

Output Instructions

Set Output Instruction (Latch) (1)

A set output instruction, or Latch, turns ON an output coil (Q) or an auxiliary contact (M) when the
preceding input contact transitions from OFF to ON. Once the output is ON or set, it will remain ON until
it is reset using the Reset output instruction. It is not necessary for the preceding input contact
controlling the Set output instruction to remain ON.

I1 o1
oo1 | 5
11
OFF ON OFF
Ql OFF O™

Reset Output Instruction (Unlatch) ()

A reset output instruction, or Unlatch, turns OFF a previous set output coil (Q) or an auxiliary contact (M)
when the preceding input contact transitions from OFF to ON. Once the output is OFF or reset, it will
remain OFF until it is reset using another output instruction. It is not necessary for the preceding input
contact controlling the Reset output instruction to remain ON.

IZ 2l
o001 | |
11 OFF ON OFF
ON OFF
0
1 j International Office: .bb-elec. E Office: .bb- .
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Chapter 4: RLL Programming E

Pulse Output Instruction (Flip-Flop) (P)

A pulse output instruction, or Flip-Flop, turns ON a coil (Q) or an auxiliary contact (M) when the
preceding input contact transitions from OFF to ON. Once the output is ON, it will remain ON until the
preceding input contact transitions from OFF to ON a second time. In the example below, When
Pushbutton 13 is pressed and released Motor Q4 will turn ON and remain on. When Pushbutton 13 is
pressed again, Motor Q4 will turn OFF and remain OFF. The pulse output instruction (P) will “flip-flop” its
state from ON to OFF at each press of Pushbutton 13.

I3 o
001 I -
Phutton Motor

1 OFF |ON | OFF [ON| OFF  [ON|OFF

11\_

0 N OFF N OFF
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E Chapter 4: RLL Programming

Counter Instructions

The SG2 PLR includes a total 15 separate counters that can be used throughout a program. Each
counter has a choice of 8 operation modes, 6 for general purpose counting and 2 for high speed
counting. Additionally, each counter has 6 parameters for proper configuration. The tables below
describes each configuration parameter and lists each compatible memory type for configuring counters.

Symbol |Description Compatible Instructions Range
_® ] (1) | Counting Mode (1-6) Inputs 11-IC / i1-iC

®_ @ Use (I1 ~ gF) to set counting up or counting down | | Qutputs Q1-Q8/q1-g8
@ OFF: counting up (0, 1, 2, 3, 4....) Auxiliary coil M1-MF / m1-mF

(3) |ON: counting down ( ....3, 2, 1, 0) Expansion inputs X1-XC /x1-xC

®_ @ Use (I1 ~ gF) to RESET the counting value Expansion outputs Y1-YC / y1-yC

—® @ ON: the counter resets to zero and OFF RTC R1-RF / r1-rF

OFF: the counter continues to count Counter C1-CF / cl-cF

@ Present Counting Value, range:0~999999 Timer T1-TF / t1-tF

Target (Setting) Value, range:0~999999 Analog comparator G1-GF / g1-gF

@ Code of the counter (C1 ~ CF total: 15 counters)

Edit Contacl/Coil

The figure to the right shows
the relationship between the
numbered block diagram for

a Counter, the ladder (&) c M=) aesaecoen
diagram view, and the ~ Funcesen
software Edit Contact/Coil Q\}— r\@ _(;E) mede [t | (1-8)

dialog box.
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Chapter 4: RLL Programming E

Counter Mode 1 (Fixed Count, Non-Retentive)

Mode 1 Counter will count up to a fixed preset value and stop counting when the current count is equal
to the preset value. Additionally, the current count value is non-retentive and will reset to zero on a loss
of power to the PLR. In the example below, the counter will stop counting when it reaches the preset
value of 20. Counter status bit C1 will be ON when the current value is 20.

Edil Contact/Coil

_(9 —
@)— ] : " T = B alk

Salect Coil WO futput Typs

@ c Al -] i-eamcoEm 2o
CH @ ® |

Hode |1 . {L=8)

Councer without cvesrtaling and wickhour
povar down FeCALD CUrERRT valus

1
1 Current valus: |BRE00D
\‘\.\_\_,_,-"I Preset valus: |PFFOID
M14 000000
Fresst type: |N -
0ooozZo ol 8
Iz Direecion Set Resat Inpuc
Concase (A - 1 Concase |1 -

O 20 |
T R Ve Suss Wade aels rabs s (o Sl Rl TR Eepte naa devie miel: ke pisis iy See
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E Chapter 4: RLL Programming

Counter Mode 2 (Continuous Count, Non-Retentive)

Mode 2 Counter will count up to a fixed preset value and continue counting after the preset value.
Additionally, the current count value is non-retentive and will reset to zero on a loss of power to the PLR.
In the example below, the counter will continue counting after its preset value of 20. Counter status bit
C1 will be ON when the current value is 20.

2
M14 000000
oooozao ol
IZ

Edit Contact/Coil

"

Falact Coll RO

Frezatc type
Dirscrion Sac

Contmct M

I (2],

Output Type
I

gl ] (1-8 A B;C.D,X.F)
Funeeios
il - {L=81
Counter with avertaliing and wiehous
pever doim recaln curcent yalus
Curpant salus: 000000
Proset walus: |QDODZD

Baser Trpur

1 Concmct: | § - -

Cancal

4

3]

Q=2

9,
@ 1o}

gl

20

R R e i i G ey ) e s i) VS T R Rk B A pa e er |
19120,20,21\21120\ 20\ 19} 191 18,18} 0 | 0 |19} 19} 20 0 | 20

SG2 PLR User Manual ‘

Secure online ordering 24/7/365 from

B:3

electronics

MANUFACTURING COMPANY

707 Dayton Road - P.O. Box 1040
Ottawa, IL 61350 USA

815-433-5100
orders@bb-elec.com  support@bb-elec.com

Fax 815-433-5104 +353

B
fomaCoust pulse b-t-4-

@ OFF 0N OFF ﬂ_H

@ OFF ON

@ QFF (N OFk ON QFF | ON] OFF

Westlink Commercial Park
Oranmore, Co. Galway, Ireland

91792444 Fax +353 91 792445

orders@bb-europe.com  support@bb-europe.com



Chapter 4: RLL Programming ﬂ

Counter Mode 3 (Fixed Count, Retentive)

Mode 3 Counter operation is similar to Mode 1 except its current count value is retentive. Mode 3 Counter will
count up to a fixed preset value and stop counting at that value. Additionally, the current count value is retentive
and will keep its current count after a loss of power to the PLR. In the example below, the counter will stop
counting when it reaches the preset value of 20. Counter status bit C1 will be ON when the current value is 20.

@ Edit Cantact/Cail =
Q T " T :

Zalace 1 i}
O
C |1 | (1=5, A, B, C.D L. F}
- 1: 5 :: Function
®_ @ Mods (3 *| (1B}

CounEar Withoub overcaling and wich
povar dovm rFeCAln CUrCEnt valus

P

(:1 Currant walus; [00O000
Presst value: |00D0Z0
_O 3
______ Preset cyps: |N -
M14 000000
Tirsction fac Fazet Inpus
000020 pCl el Sl: (I anmr =
I2

Counter Mode 4 (Continuous Count, Retentive)

Mode 4 Counter operation is similar to Mode 2 except its current count value is retentive. Mode 4
Counter will count up to a fixed preset value and continue counting after the preset value. Additionally,
the current count value is retentive and will keep its current count after a loss of power to the PLR. In the

example below, the counter will continue counting after its preset value of 20. Counter status bit C1 will
be ON when the current value is 20.

Edit Contact/Cail

—@ E— ] m T L " L
@- Ealact Coil WD Ouepue Type

@ £ =l fl-%AB.C.0D.EF i
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G @ —(6) roce =] 10

S

founter with overtaliing and with power
dowvmn refain current value

Currast valus: |[000O000

-
-'1 Preset valus: [DOOGZ0
_O 1
Pressc Typa i -
M14 0OO0000
Diraseisn Jat Ragas Imngue
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E Chapter 4: RLL Programming

Counter Mode 5 (Continuous Count, Up-Down Counter, Non-Retentive)

Mode 5 Counter operation is similar to Mode 2 where its current count value is continuous and non-
retentive, except its C1 status bit will only be ON when the counter counts up to its preset, or down to its
preset from a count higher than its preset. Even with its direction bit set to ON, it will not turn on its C1
status bit when it counts down to zero. The C1 status bit is fixed to the non-zero preset value regardless
of the state of the direction bit. Additionally, the Mode 5 counter is always reset to zero, unrelated to the

state of its direction bit.

The Mode 5 Counter will count up to a fixed preset value and continue counting after the preset value.
Additionally, the current count value is non-retentive and will reset to zero on a loss of power to the PLR.
In the example below, the counter will continue counting after its preset value of 20. Counter status bit
C1 will be ON when the current value is 20.

Edit Contact/Caoil
(—E-\.-l_ Select Coal RO fhat puis : Ypa
@ (= = =2k B.C.D E.T) i
Function
> @ o | .
Current valis oonooa 3
£l Prases valus: [000020
rf“‘\l 5 Fregat type! [N -
1\'-...4-"'; Ml |-||-|| ||,.||:||.| E-::n-:--:l.-:-h Tt Bagnt Tnpus
DDDDED ':I. Contact |H - 1 Contact |I -
1z
D=5
__________________________________________________ =
@ 20 |
e e R e FR R [ S sl et i ristes bk e R At i e e |
@  10l19119120 201211211201 201191 191 181 181 191191201 01 0} 9! 0]
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Chapter 4: RLL Programming E

Counter Mode 6 (Continuous Count, Up-Down Counter, Retentive)

Mode 6 Counter operation is similar to Mode 4 where its current count value is continuous and retentive,
except its C1 status bit will only be ON when the counter counts up to its preset or down to its preset
from a count higher than its preset. Even with its direction bit set to ON, it will not turn on its C1 status bit
when it counts down to zero. The C1 status bit is fixed to the non-zero preset value regardless of the
state of the direction bit. Additionally, the Mode 5 counter is always reset to zero, unrelated to the state
of its direction bit.

The Mode 6 Counter will count up to a fixed preset value and continue counting after the preset value.
Additionally, the current count value is retentive and will keep its current count after a loss of power to
the PLR. . In the example below, the counter will continue counting after its preset value of 20. Counter
status bit C1 will be ON when the current value is 20.
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m Chapter 4: RLL Programming

High Speed Counters (DC Version PLRs Only)

The DC powered version PLRs include two 1Khz high speed inputs on terminal I1 and 12. These can be
used as general purpose DC inputs or can be wired to a high speed input device (encoder, etc.) when
configured for high speed counting. These are often used for counting something moving very fast
(>40hz) or used as a speed reference on a machine. The high speed counters are configured using the
same software Edit Contact/Coil dialog box, except selecting Counter Mode 7 or Mode 8.

High Speed Counter Mode 7 (DC powered versions only)

The Mode 7 High Speed Counter can use either input terminals 11 or |12 for forward up-counting to 1Khz
maximum at 24VDC high speed input signal. The selected Counter Coil (C1-CF) will turn ON when the
pulse count reaches the target setpoint and remain ON. The counter will reset when the preceding rung
is inactive or the Reset Input is active.

_@ Symbol |Description
@_ (1) | Counting Mode (7) high speed counting
(2 |High speed counting input terminal: 11 or 12 only
@ Use (11 ~ gF) to RESET the counting value
@ ON: the counter reset to zero
OFF: the counter continues to count
5
®_ Q —® (@) |Current Count Value, range:0~999999
(6) |Preset Value, range:0~999999
@ Counter Coil Number (C1 ~ CF total: 15 counters)
The figure to the right shows the (1) —
relationship between the numbered €)™ g S L R L O
block diagram for a Mode 7 Counter, (1) : # e
the ladder diagram view, and the :’ FHMRLDIRE
software Edit Contact/Coil dialog box. @_ {5) () Puncedsn
- i Heds -
Beale In
cl Curresd Valus 0000
f-h‘\' F." Praaat Faw Q000
\.__/'I Il !_II_':_'I!_ ._-“. FrasaT Typa 1] -
HAC 050000 pc1 Tmput I1/13 Rapws Trguc
i e et 1 Comtast n -
il 4 .'lr:'_c_
@=7
@ 999999 :
----- e e e e S e I .
Ly gd kg | .. 'o999951999999/999999/999999, ¢ | o |
e .
@ e b b
@ oN OFF oN
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Chapter 4: RLL Programming n

High Speed Counter Mode 8 (DC powered versions only)

The Mode 8 High Speed Counter can use either input terminals 11 or 12 for forward up-counting to 1Khz
maximum at 24VDC high speed input signal. The selected Counter Coil (C1-CF) will turn ON when the
pulse count reaches the target “Preset ON” value and remain ON until the pulse count reaches the
target “Preset OFF” value. The Fixed Time xxxx. The counter will reset when the preceding rung is
inactive.

The table below describes each configuration parameter for High Speed Counter Mode 8

_@ Symbol |Description
@_ (1) | Counting Mode (8) frequency comparison
@ High speed counting input terminal: I1 or 12 only
@ Use (11 ~ gF) to RESET the counting value
@ ON: the counter reset to zero
@ OFF: the counter continues to count
®— —@ @ Current Count Value, range:0~999999
@ Preset Value, range:0~999999
@ Counter Coil Number (C1 ~ CF total: 15 counters)
The figure to the right shows the (1) —
relationship between the numbered f:é)— e e B ke
- bl Ceil RO Duspue Typd
block diagram for a Mode 8 Counter, (1) s
the ladder diagram view, and the =i ¢ ML o9 8.0 8 0
software Edit Contact/Coil dialog box. 3 (5) F= P
B _rl 6 } Had i - L=
1K H= Impur Counc
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Timer Instructions

The SG2 PLR includes a total of 15 separate timers that can be used throughout a program. Each timer
has a choice of 7 operation modes, 6 for general purpose timing and 1 (mode 7) for a pulse timer.
Additionally, each timer has 6 parameters for proper configuration. The table below describes each
configuration parameter and lists each compatible memory type for configuring counters.

_ Symbol |Description Compatible Instructions Range
C <j () |Timer Mode (1-7) Inputs 11-IC / i1-iC
Timer Unit: 0.00 - 99.99 sec Outputs Q1-Q8/91-98
@ ® 0.0 - 999.9 sec - -
0 - 9999 sec Auxiliary coil M1-MF / m1-mF
O 0 - 9999 min Expansion inputs X1-XC /x1-xC I
@_ L _@ ® ON: the timer reset to zero Expansion outputs Y1-YC / y1-yC
OFF: the timer continues to time RTC R1-RF / r1-rF
(@) |Current timer value Counter C1-CF / c1-cF
(6 |Timer preset value Timer T1-TF / t1-tF
@ Timer Coil Number (C1 ~ CF total: 15 timers) Analog comparator G1-GF / gl1-gF

Timer Mode 1 (ON-Delay)

Mode 1 Timer (ON-Delay will time up to a fixed preset value and stop timing when the current time is
equal to the preset value. Additionally, the current time value is non-retentive and will reset to zero on a
loss of power to the PLR. In the example below, the timer will stop timing when it reaches the preset
value of 5 seconds. Timer status bit T1 will be ON when the current value is 5.

o I
[EI-?DE }T]
=]
E% Enabie Reset Relay —Pid— f_ﬂ_f] — | Enable Reset Relay
s T - - =i Present Value=0
Present Value={l Tuner Starts Operating
Timing enable Relay OFF ON OFF
+— | —p
s - ®
| Time up, (TI~TF) OFF ON OFF
|Cutput Terrranal
t=Timer Target Value
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Timer Mode 2 (ON-Delay with Reset)

Mode 2 Timer is an ON-Delay with reset that will time up to a fixed preset value and stop timing when
the current time is equal to the preset value. Additionally, the current time value is non-retentive and will
reset to zero on a loss of power to the PLR. The timer reset input is Input | 1. In the example below, the

timer will stop timing when it reaches the preset value of 5 seconds. Timer status bit T1 will be ON
when the current value is 5.
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_ B e
S 3 T =
B St 34 oooo Dicaction o
0o0s T1 ol
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Enable resel relay —pul— oo ctarts o perating > Enable reset relay
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m Chapter 4: RLL Programming

Timer Mode 3 (OFF-Delay)

Mode 3 Timer is an OFF-Delay with reset that will time up to a fixed preset value and stop timing when
the current time is equal to the preset value. Additionally, the current time value is non-retentive and will
reset to zero on a loss of power to the PLR. In the example below, the timer reset input is Input I11. Also
in the example below, timer status bit T1 will be ON immediately when its rung is true. The timer will
only begin timing up when its rung changes to false. Timer status bit T1 will turn OFF when the current

time value reaches 10 seconds.

&
®

G+ @

p——

e |3 bt QLS E0 R B

Ore-delay timer asds L

Eddit ContactiCoil |

Tims Basw 1 -
2 pmeed
p 34 oooo ” B
0010 T1 Hh g
Il
[ (1] 13 | BILCE
efiable reset relay — | G_} eniable reset relay
present value =0 Timer statts operating present value =0
Titring enahle relay OFF OM OFF
(&)
o sy O ON |41 —»| OFF
output terminal @
@] eriabile reset relay QOFF
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Chapter 4: RLL Programming E

Timer Mode 4 (OFF-Delay)

Mode 4 Timer is an OFF-Delay with reset that will time up to a fixed preset value and stop timing when
the current time is equal to the preset value. Additionally, the current time value is non-retentive and will
reset to zero on a loss of power to the PLR. In the example below, the timer reset input is Input | 1.
Also in the example below, the timer status bit T1 will turn ON only after its rung transitions from true to
false. Timer status bit T1 will turn OFF when the current time value reaches 10 seconds.

(D —

@ @ Lo (IFEE—

Ore-delay timer asds L

@

Tl Frage: walus: |QODE Bac
ﬁ 3 Timawt tyne 1 -
p 34 oooo - _. : B
0010 o ﬁ _ .I.-_, :
Il !
efiable reset relay — | G_} 4 onable reset relay
present value =0 Timer statts operating present value =0
Titring enahle relay OFF OM OFF
(6)
—— crny OFF ON |41 —»| OFF
output terminal @
@] eriabile reset relay QOFF
t= target value set in timer
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m Chapter 4: RLL Programming

Timer Mode 5 (FLASH without Reset)

Mode 5 Timer is a Flash timer without reset that will time up to a fixed preset value then change the
state of its status bit when the current time is equal to the preset value. Additionally, the current time
value is non-retentive and will reset to zero on a loss of power to the PLR. In the example below, timer
status bit T1 will be ON immediately when its rung is true and begin its timing sequence. Timer status
bit T1 will turn OFF when the current time value reaches its preset of 10 seconds. This Flash sequence
of the timer status bit T1 will continue as long as its rung remains true.

_@ Edit Contact!Codl El

a9 T g E 4
@ i
Salect Cwuil RO St Y
@ T = -9 A B 0D, F I
. i Fimesion
Tl Tims Baws: |l DEC =
II(""_""\.'I g Current valus: |[0000 ac
U ad oooo Prases walua: (D040 Zas
oo10 Tl el A o ™
DirecThon Sat Bepsr Tigrus

Enable reset rely |
P e —p—  Timer starts opersting —b|-1— Enable reset relay
* Present valhue =1

Turinig enable relay

Time up,

output terminal (T1-TF)

t=target value set in times
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Chapter 4: RLL Programming n

Timer Mode 6 (FLASH with Reset)
Mode 6 Timer is a Flash timer without reset that will time up to a fixed preset value then change the
state of its status bit when the current time is equal to the preset value. Additionally, the current time
value is non-retentive and will reset to zero on a loss of power to the PLR. In the example below, the
timer reset input is Input | 1. Also in the example below, timer status bit T1 will be ON immediately when
its rung is true and begin its timing sequence. Timer status bit T1 will turn OFF when the current time
value reaches its preset of 5 seconds. This Flash sequence of the timer status bit T1 will continue as

long as its rung remains true.

@ Edit ContactiCoil
H i 8 B ik

T1 r L ‘
ﬁ [ ot waluar [0 .
U 3 I:”:”:”:l Pramet Type: (U =
DDDS Tl biga B |-.,:.- Legri
Il :
o] omeas

enable resel relay | , enable reset relay
present vahue =0 "|" Timerstats opersting 9 (e valye =0

Timing enable relay —|
AR EAE

Timne up,
Catput termdnal (TI~TF)

enahle reset relay _l

t=target value set i times
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n Chapter 4: RLL Programming

Timer Mode 7 (FLASH Cascade without Reset)

Mode 7 Timer is a Flash timer without reset that uses two timers in a cascade configuration. The
cascade configuration connects the timer status bit of first timer to enable the second timer. The second
timer will time up to its preset value then flash and its timer status bit will enable the first timer.
Additionally, the current time value is non-retentive and will reset to zero on a loss of power to the PLR.
In the example below, timer status bit T1 will be ON after it completes its timing sequence of 2.5
seconds. Timer 2 will then begin its timing sequence of 1 second. When the current time value of Timer
2 reaches its preset of 1 second, its status bit T2 will flash and Timer 1 will begin timing again.

This type of cascade timer is of ten used in combination with a counter in applications where it is
necessary to count the number of time cycles completed.

@ Note: Timer Mode 7 uses two timers. These timers cannot be reused as timers for other modes in other areas of the
=)y program.

|
%
()
—
-
=
*

Edit Cantact/Cail x|

Q L3 n T C j bl L

@

ey
\o)

_® Function

Hods =B:=[.7:7)

G-

Flash tissr mods 3

Tl T2
_® ¥ Eurvant valus: |[000.0 Enc [O00_D Fae
24 000.0 ;
002. 5 T Prasec value: |002.5 Sac (0010 Zas
2 Praset type: |N - H -
Dirsccion Sac Rezar Ingurc
Comtase Contast
ki
24 000.0 okt Cancel
oo1.0  pTZ
T2
enahble reset relay Enable reset relay

present value =0 —pl-(—TmLE] SRS UpaHPng ﬂ—present valae =0

timing enable relay

Timer up,
oty termanal {T1-TF )

tl = target value set in the first timer
t2 = target value setin the second timer
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Chapter 4: RLL Programming E

Real Time Clock (RTC) Instructions
The SG2 PLR includes a total of 15 separate RTC instructions that can _

be used throughout a program. Each RTC instruction has a choice of 3 Time Sec
operation modes, and has 10 parameters for proper configuration. The Tear/Month/Day: [ps  slos /|20
initial clock/calendar setting for each connected SG2 is set using the

Hour :Minute 08 - |E0
Operation»RTC Set menu selection from the SG2 Client software.
. 0K Cancel
Daily Mode 1 x|

The Daily Mode 1 allows the Rx coil to activate based on a fixed time across a defined set of days per
week. The configuration dialog below allows for selection of the number of days per week (i.e. Mon-Fri)
and the Day and Time for the Rx coil to activate ON, and Day and Time for the Rx coil to deactivate OFF.

Interval Time Mode 2 (weekly)

. Ll EontactiCall
o (D=0 [ e
e —_ ooz Cond WD St pus Typs —
‘\',i;] = (5) Symhol |Description
M = phlaEe Rl (1) |Input the first day to RTC
o T ST L
(6) : | 7) ¥ (2 |Input the second day to RTC
e A | iebi [ =] i) (3 |RTC mode 1
2] - L_{U g e s (@) |RTC displays the hour of present time.
@ RTC displays the minute of present time
= etk S (&) |Set RTC hour ON
— :.,.r.‘. .;..u o T (7) |Set RTC Minute ON
{ } Set RTC Hour OFF
15:00 Rl
15:20 e = (9) |Set RTC Minute OFF
= [P " s meh RTC Coil Number (Rl“RF Total: 15 RTCS)
| o ance

The Interval Time Mode 2 allows the Rx coil to activate based on time and day per week. The
configuration dialog below allows for selection of Day and Time for the Rx coil to activate ON, and Day
and Time for the Rx coil to deactivate OFF.

=G N
fﬁ— = 3 . : 1 T Symbol Descrlptln.n
" o s s v o (1) |Input the first day to RTC
() :(35) : A aasmear o (@ |Input the second day to RTC
. (3 |RTC mode 2
(&) : (2) m "_'“'"L'“ i (@) |RTC displays the hour of present time.
g) - r\:,' __._ © Thniwd Y lan BEELE - BaN (6 |RTC displays the minute of present time
i (6) |Set RTC hour ON
Waak (n=rqiet) : [T =] wer M v (@) |SetRTC Minute ON
Fuerens yaiue: [07:0 Set RTC Hour OFF
¥o walue o | 47 i (9 |SetRTC Minute OFF
RTC Coil Number (R1~RF Total: 15 RTCs)
Bigestinh Tt Baiws Tpis
o ] T
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E Chapter 4: RLL Programming

Year-Month-Day Mode 3

The Year-Month-Day Mode 3 allows the Rx coil to activate based on Year, Month, and Date. The
configuration dialog below allows for selection of Year and Date for the Rx coil to activate ON, and Year
and Date for the Rx coil to deactivate OFF.

—@ @0 ([

Symbol |Description
O— @ L R (@ |RTC mode 3. Year-Month-Day
q (2 |SetRTC Year ON
©/© 'l (3 |SetRTC Year OFF
— (@) gty (@ |Displays RTC current time: Year-Month-Day
O/ T S (6) |Set RTC Month ON
(8) |SetRTC Day ON
e Tt ER X @) |SetRTC Month OFF
e T Set RTC Day OFF
R2 Peeen valus:| 97 | 1% o | 0 " (@ |RTC coil number (R1-RF Total: 15 RTCs)
06-08
34 000000 ; : ‘ e
'[m 19 ]p; et 1 || comesail—
9.03
| i L ] Cancel

Symbol |Description

RTC mode 3, Year-Month-Day

Setting RTC Year ON

Setting RTC Year OFF

Display RTC Present time: Year-Month-Day
Setting RTC month ON

Setting RTC Day ON

Setting RTC month OFF

Setting RTC Day OFF

RTC Code (R1~RF, total 15 group)

©® Q@ ®E®E
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Chapter 4: RLL Programming E

Comparator Instructions

The SG2 PLR includes a total of 15 separate comparator instructions that can be used throughout a
program. Each comparator has a choice of 5 operation modes. Additionally, each comparator has 7
parameters for proper configuration. The table below describes each configuration parameter, and lists
each compatible memory type for configuring counters.

_ @ N Symbol | Description
(1) | Comparison Mode(1~5)
@ 1 @ @ Ay analog input (A1~A8), the present value of the timer, counter, or a constant value.
@ Ay analog input (A1~A8), the present value of the timer, counter, or a constant value.
@ @ Ay analog input value(0.00~9.99)
@ ] | @ @ Ay analog input value (0.00~9.99)
@ @ Set refgrence comparative value: could be constant, or the present value of the timer, counter and
analog input.
(@) |Output terminal(G1~GF)

Comparison Mode 1 (Av - (6) = Ax= Av + (6), (7) ON)
Comparison Mode 2 (Ax < Av, (7) ON)
Comparison Mode 3 (Ax = Ay, (7) ON)
Comparison Mode 4 (Ax = (&), (7) ON)
Comparison Mode 5 (Ax = (&), (7) ON)

Example 1: Analog Signal Compare

In the example below, Mode 4 is the selected function that compares the value of analog input Al to a
constant value (N) of 2.50. Status coil G1 turns ON is Al is <= to 2.50.

£ dit Contact/Coll

Balace Coil O thatpugt Typsa

Function

'_® Mode |4 #i{ (1=K}

Ax <= RBafarsncd walus

@
@
@ G |1 T§ (iR A B.CDEF)
@

Az Ay
i1 - Az -
Currenc walua: (040,00 Al [oo.00 Az

el Presec valus: (0250 et
[ :: 4 Prasar type: [N -

Al4 OO, OO0 Dizacrion Set Raswt Input

AZ4 00,00V pEl Contace Contace

0z .50V

I DK I Caneal
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E Chapter 4: RLL Programming

Example 2: Timer/Counter Preset Value Compare

The Comparator insturction ca nbe used to compare Timer, Counter, and RTC values to a constant
value or to each other. In this example below, Mode 5 is the selected function that compares the value of

Counter (C1) to a constant value (N) of 15 counts (the decimal point is ignored). Status coil G1 turns ON
if C1is = to 15 counts.

‘Ldit Contact/Cofl =

H T (= B G H e
@ felect Coil WO. futpus Type
!
[ F | (1=9,4,B,C,D.E.F}
Funct Lo

_® Hodw |B | (1=K}

An *= Dgfarencs valis

® ® ©06

k= Ay
CL - AT o
Current valus:; [D0.00 Cl o0, o0 AT
Praset value: |DO.LE Eaf

31
: 5 Preset Type: (K -

Cl4 00,00V Dirsction et Rerst Ingut

AZ4 00,00V k51 Cont:act Contact

00.15v

canes
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The SG2 PLR includes a total of 15 HMI
instructions that can be used throughout a
program. Each HMI instruction can be configured
to display information on the SG2 12x4 character
LCD in text, numeric, or bit format for items such as
current value and target value for timers/counters,
Input/Output bit status, RTC (real time clock) and
Analog comparator. Each HMI instruction is
configured separately using the Edit»HMI/Text
menu selection from the SG2 Client software.

In the adjacent example, HMI instruction H1 is
configured to display the value of I1 and T1, and
some descriptive text. Numeric display data
selections are Timer, Counter, RTC, and Analog.
Bit display data selections for “ON” and “OFF”
messages are “I” inputs, “M” internal relays, and “X”
expansion inputs.
Allows the SEL button on the SG2
keypad to activate the selected
message onto the LCD even when Hx
coll is inactive.

Chapter 4: RLL Programming E

HMI Display Instructions

Hi Wz [H3 [Ha |WE |HE [H7 | ral»

LNPUT FAULT Finer | RIEEETIEN -

[1=8%H Courter | =
TIMER] VALUE RTC =
T].:ﬂﬂﬂ# ,‘jgg Arislog =
v Displey ¥ Uni Codl Statuie -
| |n - il |
Anslog Display Set
Phone Nuriber M =
| i - " ot Canced
T lrpwd

Issws  ( Jw+, — #012348§780:
$<=>1dABCDEFCHI IKLMNOPQRESTU
YWXYZI~IB_" abedetubiibimnon
Irstuvus¥re|3@odaiaiicieriii
TELAERNYobodaduldnnfF~Paaze
23wt PAOIANF IR EYSFUTRF R
FIAEINTR24XERITINILLOPILEER"
cByi2tlveHB¥Gs - ~c2 "L FliidAE

v u  Allows the HMI message to include coil number and selected value (i.e. T1=003 Sec).

Analog Desplay Set
shown below.

Provides access to the Analog Display Set dialog for scaling and offset parameters

The Analog Display Set dialog allows the user to specify a scaling
e i factor (Gain) and an offset for each analog input value.

Select
A ,"1'«1 Gain [17339): 100
AZ Offzet [-BO~+50]: 10
A3
A OF. Cancel

Phione Mumber
18009720436 Add help_

—
—

A phone number can be displayed on the screen to alert an operator to call for

=)y Note: The Phone Number field does not dial a modem or allow for a modem connection.
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E Chapter 4: RLL Programming

Each HMI instruction has a choice of 2 operation modes. The table below describes each configuration
parameter.

o
E LE} A

N R [ =

Symbol

Description
Display Mode (1-2)

HMI character output terminal (H1-H8)

—( )

PWM Output Instruction (DC Transistor Output Models Only)

The transistor output model SG2 PLRs include the capability to provide a PWM (Pulse Width
Modulation) output on terminal Q1. The PWM instruction is able to output up to an 8-stage PWM

waveform.

Symhol| Description Enable| ® | @ | ® | @ Output PWM
(1) |Setdisplay stages (1~8) OFF | X X X 0 OFF
@ Display the present stage as operation(0~8) ON | OFF | OFF | OFF 1 Set stage 1
@ Input Selected Stage 1(11~gF) ON | OFF | OFF | ON 2 Set stage 2
@ Input Selected Stage 2(11~gF) ON | OFF | ON | OFF 3 Set stage 3
@ Input Selected Stage 3(11~gF) ON | OFF| ON | ON 4 Set stage 4
@ Set PWM pulse width (0~32768ms) ON ON | OFF | OFF 5 Set stage 5
(@) |Set PWM Period(1~32768ms) ON | ON |OFF| ON | 6 Set stage 6
PWM output terminal P1 ON ON | ON | OFF 7 Set stage 7

ON ON | ON | ON 8 Set stage 8

.__®@_

Salect Coil NO.

Ducpue Type

®

P (81

Q

Function

Hode

Ho Hode

Select 1-8:(1

SG2 PLR User Manual ‘

wi o
Pl Current value: 00000 mE Lol ] mE
l’fﬁ\\ 1 0 Progset wvalue: [00010 ms [alalsla 11 fors
I4
I34 00005 |FP1
T2 00010 Select input points: (High-»Low bit)+l
- I - 5 T -| | 4

Cancel
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Chapter 4: RLL Programming E

Data Link/Remote I/O Instruction (SG2-20Vxx Models Only)

The SG2-20Vxxx transistor output models include the capability to link additional SG2-20Vxx units via
the RS-485 connection terminals. Up to 8 additional SG2 units can be configured as independent Slave
nodes, each running their own logic program and their I/O linked to one Master PLR. Up to 2 additional
SG2 units can be configured as Remote 1/0O nodes, and linked to one Master PLR.

Symbol|Description Selectable Points Range
@ Mode setting (1, 2) 1:sending 2:receiving Inputs 11-IC / i1-iC
(2) |Setthe send/receive points(1-8) Outputs Q1-Q8/g1-g8
(3) |Set the send/receive points Auxiliary coil M1-MF / m1-mF
(4) |Sendireceive memory list location Expansion inputs X1-XC /x1-xC
(8 |1/O link output terminal (L1-L8) Expansion outputs Y1-YC /y1-yC
a»  Note: Only one “Mode 1 Send” Data Link instruction (L1-L8) is allowed per ID | Memory List Location
i;} Master I?LR. All other Data Link instructions must be “Mode 2 Receive” 0 |wi~ws
instructions. 1 lwo-wis
The Mode 2 Receive memory range is determined by the Controller ID. 2 |wir-w24
Each controller ID is allocated a range of 8 1/0O points (Wx-WXx) that i xiz:xiz
can be read into the Master PLR using a DataLink instruction. The 5 Twaiwas
adjacent table show the memory range of Wx locations associated with 6 [Waowss
each controller ID. 7 Tws7-wea

The Data Link instruction below is setup for Mode 1 Send where the Master PLR is sending 5 I/O points
of Inputs to each connected Slave PLR. The starting Input is 103 with the resulting range of 5 sending
inputs equal to 13 — I7.

Zalact Coil MO

@ o o '

Ducput Type
=[

T (1=H)
Funcocion

Hode |1 ¥ [1=2})

Sand

Select 1l-81 5 -

L1l Frem |I03-97 =| To
(Y 1
a 5{ 103-07
|5 |5 Ll Birection Set feset Input
wmde-13 Contact Contact

Cancel
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E Chapter 4: RLL Programming

Example 1: Data Link Mode 1

Set(1) =1, (2) =5, set (3) as the initiate of 13, the state of actual sending terminal I13~17 is sent to
memory list; the controller ID = 3, the state of corresponding memory list position W17~W24- (4) and
relationship of sending terminal is as below:

M=1®@=5®:13~I7 ID =3 (@ : W17 ~ W24)

W17 WI1s W19 W20 W2l W22 Wi3 W24
- ST . B BN S S N
orresponding recetving
and sending termainal I3 I4 IS It I7 ] ] ]
Example 2: DataLink Receive mode 2
Set(1) =1, (2 =5, set (3 as start from I3, set (4) as start from W17, when enabling the Data Link, the

state ‘ON/OFF’ of 13~17 is controlled by the state of memory list position W17~W21-(2), which is irrelative
to the actual state of input terminal.

W=1@=5@:

Iemeory List Posttion

I3 ~I7 @ : W17 ~ W21

Memory List Posttion: W17 W15 W19 W20 W2l

Corrsponding Eecerving + + + + +

and Zending Terminal: I3

Salact Ceil NO

=
@ A SRS BN T

Funcocion

Ducpuc Type

_@ Hode |1 » (L=}
Fand
Coil MO : -
Select 1«85 -

i To

From |IQZ-07

OF

1
54 103-07
g jd
Wi5-13

i

Direction Sat

Contact

fezet Input

Contact

Cancel
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Chapter 5: FBD Programming E

Chapter 5: Function Block Diagram Programming

FBD Instructions

Function Block (@ Input Terminal | (2) Output Coil Range
= — _";_I\ Input [ 101~10C(12)
I gy Expansion Input X X01~X0C(12)
;’ A | '~,I Output Q Q Q01~Q08(8)
l, — | ! Expansion Output Y Y Y01~YOC(12)
@ —|N O P Q01 | Augxiliary M M MO1~MOF(15)
Toput Terminal [, 7 L_;__"__\,| Knob N N NO1~NOF(15)
— /' — HMI H HO1~HOF(15)
@Uutput Coil Type PWM p PO1(1)
@ Output Coil Block SHIFT S S01(1)
1/0 LINK L L01~L08(8)
Logic /Function Block B B01~B99(99)
Normal ON Hi
Normal OFF Lo
No Connection Nop

Coil Block Instruction

a1 = =

; ) !

/ 3 -
@ —»|NoPHQ 01> |/

Input Terminal .\\H -

@Dutput Coil Tyxpe
@ Output Coil Block

Logic Block Instructions

EOzZ

@ Logie Type

|~

F@ Logic Black S/

@ Input Ternimal\ N/O ﬁ‘\t—l J\jA N
NoOPY kB o 5
Ilq\%o 'Br;_L —

Connect with
Hext Function BElock
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E Chapter 5: FBD Programming

PWM Function Block

The PWM output terminal ‘Q1’ can output 8 PWM ;
waveforms. (only provided for transistor output version) 5 ror o PWM Function !]

Function
Ft
Eunable mputs — . 3 ol
N o p p————x w3 Swz  Swl Tims] tims)
1o 5 ~ o o 0 0
Nop | I
o o 1 L 0
-+ .
20 = g
NopdP 01 | o 1 o ! 0
‘.l;
3 s N = p L 1 u] 1 1 1 0
1 o o |1 0
1 0 1 L g
1 1 o |1 0
1 1 1 |1 ]
Symbol
Cancel

SHIFT Function Block

Symbol|Description
(1) | SHIFT code (Total 1 group)

Input termmal description

g 301 [ ——— (2) | Setoutput type (Q, Y)
) (3) | Set output shift number (1-8)
Enable mput —» [N o p | |
" " Noepd8 01 |

Slaft input  —»
| EEENT PSR |

@ Shift code @Shiﬂ: type @)= ¢ , @) 5 shift cuput range: Q1-Q5

“/ i

LY P E: QY Shift input | | | | | | | | | | | |
TNUM: 5 B
_______ _\__ B E e Q 1
o2
@ Shift number Q3
O+
o5
; i International Office: .bb-elec. European Office: www.bb-europe.com
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AND Logic Block

FBD Ladder
r— _1Bxx
1014 AND |
102 FByy
I03-L— —

Chapter 5: FBD Programming

AR -

AND (Edge) Logic Block

FBD

1014 AND |

I 024
I 03 -L1— —

L FByy

Ladder

101 102 103

Ao

Note: The input terminal is NOP which is equivalent to ‘Hi’

NAND Logic Block

FBD Ladder 101
r— —o BXX o H__
I1014NAND | ” 1 - =
= 102 | = Iil ilii
I 024 FByy %I_ —
I103-L1L— — i03 | n
NAND (Edge) Logic Block
FBD Ladder 0l
- i01 H_
X X
r— -
— d- 10z E0Z
I01{NAND | 'ml
= 1 = = —| ]
| B
I024 le_ FByy T -
I103-L— — i03 | H
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m Chapter 5: FBD Programming

OR Logic
FBD
F— —_Bxx
I014 OR |
1024 FByy
I03-L+— —-
NOR Logic
FBD
r— —— Bx x
I014 NOR |
1024 FByy
I 03-L1— —

Ladder
101

—
=
“

Ladder

STETETE

Note:The input terminal is NOP which is equivalent to ‘Lo’

XOR Logic

FBD

FBD

SG2 PLR User Manual ‘
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Ladder

101 102
N
101 102 |

S

Ladder
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Iol

-
L=
-

Inz

Inl

Ingz

Inz

Iol

o0z

Inl

10z

E0l

EOZ

"
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NOT Logic Block

FBD Ladder
r— __Bx x
Inl EOE
1014 NOT | 01 xx E|
= = NOT
B P R A m—e
L— |

Note: The input terminal is NOP which is equivalent to ‘Hi’

Pulse Logic Block
FBD Ladder

rP —
to 14 JLIL | _ 101 x| =

Il L tByy —H--—-- ®‘ E|
L— —

Note: The input terminal is NOP which is equivalent to ‘Lo’

Counter Function Block
Counter Mode 1

BX X e

Countinglnput — |C pn t ——
Up/Down Counting — | /| - J_I_
trode: 1
Reset — |R ¢ s | |—Byy e
Car Wabae: 0
Counting Parameter —> |P a r L Pre Wahue: 1024
Counter Mode 2
Counting Input Bx x Bz

Up/Down Counting
Reset

Res- | |—Byy ?ﬂaiiiz_

Par-L ¥ Pre Wahze: 128

bbb

Counting Parameter

Note:The “>"means the current value appeared will be greater than present value.
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E Chapter 5: FBD Programming

Counter Mode 3

Counting Input — |C n t —— o Bxx
Up/Down Counting =—> /A ‘| J_I_
Reset — |R e s | |—B y y
Counting Parameter — |P a r -1 PD
Counter Mode 4
Counting Input — [C n t —— Bx x B4
Up/Down Counting — | §* /{ J_I_
Reset — [R ¢ s | FB vy GRS
Counting Parameter — |P a r - } PD - T

Note:The”PD”means the current value will be retain until the power recover.
Counter Mode 5

Counting Input — |C n t —— o Bxx B0
Up/Down Counting — | I/ { - J—I_
Reset = |R ¢ = B o 5
1L By —
Counting Parameter —> [P a r L. C } - Pre ahue: 2043
Counter Mode 6
Countinglnput — O n t +— o, Bxx
Up/Down Counting — | P /¥ - J—I_
Reset =—> R e = _| | |_B vy
Counting Parameter — |P a r -LC } PD - Bre Value: 133

Note:The “C”means that will keep the current value in 0 during the Reset pin be enable.
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High Speed Counter Function Block
Counter Mode 7

Counting Input — |C' n t —— — Bxx E07
Up/Down Counting —> |E n - J_I_ |
mode: T
Reset — |R ¢ s | FByy Cowter: 7
Chr Wahze: 0
Counting Parameter — |P a r L1 / HZ - L5 T
Counter Mode 8
Countinglnpt — |C'n t —— — Bxx B8
. C
Up/Down Counting — |E n - |
J_I— mode: 8
Reset —» I —l— l_B y¥ mﬁl:n.nn
Counting Parameter — |P a r L2/ HZ - e o
Note: High speed input terminal I1, 12
Timer Function Block
Timer Mode 1 (ON-Delay A Mode)
Bx x -

=
_L_I
:||

I
—

Enable Input - |E

| ] Feyy oty

Chr Wahiel: 0.00
Timing Parameter — [P a r L — — Pre abnel: 10 00

Timer Mode 2 (ON-Delay B Mode)

Bx x BOZ

r— -
Enable Input — |En A _"_l—l_ | ﬁ
Reset — |Re s - 4'_ FB vy "T“f-,ii;:‘z

Chr Wahiel: 0.0

Timing Parameter —» |P a r L | | - Pre Wahnel: 100.0
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ﬂ Chapter 5: FBD Programming

Timer mode 3 (OFF-Delay A Mode)

r— —— Bxx B9
Enablelnpt —> |E n - _|_|_ | ﬁ
Reset — |[Resd__  FByy et

Char Wahae1: 0.00

Timing Parameter —> [P a r -1 | | Pre Vahael: 8.00

Timer mode 4 (OFF-Delay B Mode)

r— —— Bxx E04
Enable lnpt = |E n - | | | E
Reset — e s FByy Thase: 4
Char Wabael: 0.00
Timing Parameter — [P a r -1 i - Pre Vahuel: 150
Timer mode 5 (FLASH A Mode)
Bx x B0s

rF— —
Enable Input — |En _| |_ | @
Reset — | | | | | |-B vy Timr: 5

Chr Wabael: 0.0
Timing Parameter — [P a r - Pre Vbl 5.0
Timer mode 6 (FLASH B Mode)
Bx x B

=
_L_l
i=|
|
|

Enable Input — |E E

Reset — [Re s - | FB vy G

Chr Wabael: 0

Timing Parameter —» |P a r -1 | | || Pre Valel: 30

Timer mode 7 (FLASH C Mode)

E0OT
Bx x
r T
Enable Input — [En 4 _| |_ |
mcde: T
Timer: T
Reset — | “ | |—B vy O Vabwel: 0
Pre Wahiel: 40
Tiomer:2
Timing Parameter —> |P a r 112 Cur Vibue2: 0
Pre Wahiel: 30
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Chapter 5: FBD Programming E

RTC Function Block
RTC Mode 1 (Daily)

=]
L

Enable Input — |E

RTC Parameter — |P a r L DD

RTC Mode 2 (Weekly)

B x x B2

Enablelnppt = |E n - |

tuonide: 2
| | I-B y ¥ i

[ R
RTC Parameter =—» |P a r L+ WW O 16:30

RTC Mode 3 (Year Month Day)

Enablelnpt = |E n - |

RTC Parameter —» |P a r L MD Of. 05930
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Analog comparator Function Block
Analog Comparison Mode 1

Enable Input - |[En —+— ——_ B=xx E04
Analoglnppt = |[Ax H Ay - R |

thode: 1
Analog Input - |Ay H<=Ax =}Byy gﬁrﬂl:u.uu
Reference — |Re fL1Ay + R e e

Analog Comparison Mode 2

Enablelnpt —> [Epn —+— —— Bxx E0S
Analoglnput — |Ax - AX |

mode: 2
Analog Input - |laAy A <Ay FByy g“:ﬂiil:u.uu
Reference — |Re f-L - AT T

Analog Comparison Mode 3

Enable Input - |[En —T— —n Bx x Eas
Analoglnput — |Ax - Ax | ﬁ
mode: 3
Analog: 3
Analog Input - (Avy = ZAy FByy falog s
Cr Wabael: 0,00
Reference — |Re -1 - Ref Wabie: 0.00
Analog Comparison Mode 4
Enable lnput —> [En —+— —n Bx x -
Analoginput —> |Ax - Ref | @
mode: 4
Analog Input = | =Ax FByy fnalog: 4
Chr Wahael: 0,00
Reference - |R e f-L1 _I Fef Wahae: 23.00
Analog Comparison Mode 5
Enable Input = |En —T— — Bx x -
Analoglnput — |Ax - Ref | @
mode: 5
Analog Input ~ —> | =Ax FByy T
Cr Wabel: 0,00
Reference — [Re f-L - R Value: 0,10
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